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— NOTE

1. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in

any form, or by any means, mechanical, electronic, photocopying, recording, or otherwise, without the prior
written permission of OMRON.

2. No patent liability is assumed with respect to the use of the information contained herein.

Moreover, because OMRON is constantly striving to improve its high-quality products, the information contained
in this manual is subject to change without notice.

3. Every precaution has been taken in the preparation of this manual. Nevertheless, OMRON assumes no responsi-
bility for errors or omissions.

Neither is any liability assumed for damages resulting from the use of the information contained in this publication.

— Trademarks

» Sysmac and SYSMAC are trademarks or registered trademarks of OMRON Corporation in Japan and other
countries for OMRON factory automation products.

» Microsoft, Windows, Excel, Visual Basic, and Microsoft Edge are either registered trademarks or trademarks of
Microsoft Corporation in the United States and other countries.

» EtherCATe is registered trademark and patented technology, licensed by Beckhoff Automation GmbH, Germany.

Other company names and product names in this document are the trademarks or registered trademarks of their
respective companies.

— Copyrights

» Microsoft product screen shots used with permission from Microsoft.

« This product incorporates certain third party software. The license and copyright information associated with this
software is available at http://www.fa.omron.co.jp/nj_info_e/.
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1. Related Manuals

To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for the devices that are used in the

system.

The following shows the manuals for OMRON Corporation (hereafter referred to as OMRON)
and Delta Tau Data Systems, Inc (DT).

Manufacturer | Manual No. | Model Manual name

OMRON 1610-E1 Model CK3E-1J10 CK3E-series Programmable
Multi-Axis Controller Hardware
User’s Manual

OMRON 0O036-E1 Model CK3M-CPU11 | CK3M-series Programmable

Model CK5M-CPU1[11 | Multi-Axis Controller

Hardware User’s Manual

OMRON E429-E1 Model EBNW-ECT EtherCAT® Digital Sensor
Communication Unit Operation
Manual

DT 0014-E - Power PMAC User’s Manual

DT 0015-E - Power PMAC Software Reference
Manual

DT 0016-E - Power PMAC IDE Users Manual




2. Terms and Definitions

Term Explanation and Definition

Slave Slaves are devices connected to EtherCAT. There are various types of
slaves such as servo drivers handling position data and I/O terminals
handling the bit signals.

Object Represents information such as in-slave data and parameters.

PDO One type of EtherCAT communications in which Process Data Objects

communications
(Communications
using Process Data
Objects)

(PDOs) are used to exchange information cyclically and in real time.
This is also called “process data communications”.

PDO Mapping The association of objects used for PDO communications.

PDO Entry PDO entries are the pointers to individual objects used for PDO
mapping.

ESlI file An ESI file contains information unique to the EtherCAT slaves in XML

(EtherCAT Slave format.

Information file)

You can load ESI files into the Power PMAC IDE, to easily allocate
slave process data and make other settings.

ENI file
(EtherCAT Network
Information file)

An ENI file contains the network configuration information related to
EtherCAT slaves.

Power PMAC IDE

This computer software is used to configure the Controller, create user
programs, and monitor the programs.
PMAC is an acronym for Programmable Multi-Axis Controller.
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Precautions

(1) Understand the specifications of devices that are used in the system. Allow some margin
for ratings and performance. Provide safety measures, such as for installing a safety
circuit, in order to ensure safety and minimize the risk of abnormal occurrences.

(2) To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for each device that is used in
the system.

(3) The user is encouraged to confirm the standards and regulations that the system must

conform to.

4) ltis prohibited to copy, reproduce, or distribute a part or the whole of this document

without the permission of OMRON Corporation.

(5) The information contained in this document is current as of Nov 2022.

It is subject to change without prior notice for improvement purposes.

—

The following notations are used in this document.

Indicates a potentially hazardous situation which, if not avoided,
may result in minor or moderate injury, or may result in serious
injury or death. Additionally, there may be severe property

/A WARNING

damage.

T C t Indicates a potentially hazardous situation which, if not avoided,
aution may result in minor or moderate injury, or property damage.

Precautions for Correct Use

Precautions on what to do and what not to do to ensure correct operation and performance.

Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operations easier.

Symbols

The filled circle symbol indicates operations that you must carry out.
The specific operation is shown in the circle and explained in text.
This example indicates a “general precaution” for something that you must

carry out.




4. Overview

This document describes the procedures used to connect the OMRON High Functionality
Digital Sensor Communications Unit model E3NW-ECT (hereafter referred to as the Slave)
using OMRON Programmable Multi-Axis Controller model CK3E-LI I/ CK3M-CPU11/
CK5M-CPU101 (hereafter referred to as the Controller) and EtherCAT, as well as for
checking the connection.

Refer to Section 6 EtherCAT Connection Procedure to learn about the setting methods and
key points to perform PDO communications via EtherCAT.



5. Applicable Devices and Device Configuration

I 5.1. Applicable Devices

The applicable devices are as follows:

Manufacturer Name Model
OMRON Programmable Multi-Axis Controller Model CK3E-OO OO
OMRON Programmable Multi-Axis Controller Model CK3M-CPU1[1
Model CK5M-CPU11
OMRON Sensor Communications Unit (EtherCAT
Model E3NW-ECT
type)
OMRON Smart Amplifier Unit
Smart Fiber Amplifier Model E3NX-FAQ
Smart Laser Amplifier Model E3NC-LAO
Smart Laser(CMOS) Amplifier Model E3NC-SAQ0

IE' Precautions for Correct Use

In this document, the devices with models and versions listed in Section 5.2 are used as
examples of applicable devices to describe the procedures to connect the devices and check
their connections.

You cannot use devices with versions lower than the versions listed in Section 5.2.

To use the devices mentioned above with models not listed in Section 5.2 or versions higher
than those listed in Section 5.2, check the differences in the specifications by referring to the
manuals before operating the devices.

@ Additional Information
This document describes the procedures to establish the network connections. It does not
provide information on operations, installations, wiring methods, device functionalities, or
device operations, which are not related to the connection procedures. For more information,
refer to the manuals or contact your OMRON representative.



I 5.2. Device Configuration
The hardware components to reproduce the connection procedures in this document are as

follows:

Power PMAC IDE Model CK3M-CPU101
Model ESNW-ECT

=

-

EtherCAT communications

Manufacturer Name Model Version
OMRON Programmable Multi-Axis Model CK3M-CPU1CI1 | Ver.2.7
Controller
OMRON Ialr%l[tal Sensor Communication Model E3SNW-ECT Ver. 1.0
OMRON Smart Fiber Amplifier Model E3NX-FAQ Ver. 1.0
OMRON Ethernet cable (with industrial | Model
Ethernet connector) XS5W-T421-CIMO-K
DT Power PMAC IDE - Ver.4.2

IE' Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

IE' Precautions for Correct Use

Do not share the connection line of EtherCAT communications with other Ethernet networks.
Do not use devices for Ethernet such as a switching hub.

Use the Ethernet cable (double shielding with aluminum tape and braiding) of Category 5 or
higher, and use the shielded connector of Category 5 or higher.

Connect the cable shield to the connector hood at both ends of the cable.

@ Additional Information
This document describes model CK3M-CPU1[1 as an example. The same procedures can
apply to model CK3E-I[1/CK5M-CPU1I.

[(e]



6. EtherCAT Connection Procedure

This section describes the procedure for connecting the Controller with the Slave via
EtherCAT. The description assumes that the Controller is set to factory default.

| 6.1. Workflow

Take the following steps to operate the PDO communications via EtherCAT after connecting

the Controller with the Slave via EtherCAT.

6.2 Preparation for the Controller Setup

v

6.2.1 Creation of a New Project

v

6.2.2 Initial Settings of the Controller

\%

6.3 Installation of ESI Files

v

6.4 EtherCAT Communications Setup

v

6.4.1 Communications Setup for the EtherCAT Master

v

6.4.2 Distributed Clock Setup

\4

6.4.3 PDO Map Settings

\4

6.4.4 Creation of an EtherCAT Network Information
File

v

6.5 Controller Settings

v

6.5.1 EtherCAT Communications Check

v

6.5.2 Writing the User Program

v

6.5.3 Project Data Transfer

10

Prepare the Controller settings.

Install the ESI file for the Slave into
PowerPMAC IDE.

Set up EtherCAT communications.

Set up the Controller.



I 6.2. Preparation for the Controller Setup

Prepare the Controller settings.

6.2.1. Creation of a New Project

1 Turn on the power to the
Controller.

2 Start Power PMAC IDE.

* If the dialog for confirming &

access rights appears upon F":""“'TBF'E"“'”*'-':

start-up, select starting of Power
PMAC IDE.

3 The Communication screen
appears. Specify the IP address
of the destination Controller and
click Connect.

IF Address 192.168.0.200

* The IP address of the Port 22
Protocol
Controller is set to Lzer root
“ » Pazszword L1l 11101 )
192.168.0.200 by default. SelectDevice AtStartup True

* If necessary, change the
Windows IP address to

“192.168.0.X". [1P Address
Set IP Address

Connect I [ Lazt Sezzion IP I | Mo Device ]

For detailed setup options go to Tools menu -> Options
-> PowerPMAC

11
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Power PMAC IDE starts, and is
online to the Controller.

D G0 Sew Oewn Lok Ol Gheial L

o Pl-ax

eman £ gFgi

P smn, msem-,
5 v Tt [5] o R | 5 Yok arger 77 povuset o TPt

Metod1] Dasas o Power PMAC Configuration Workflow er
Mot o @ rowerPvAC IDE [ } e ]
Ceomlithane o L

Coordliifroghaie 0
Crara1PraPTTeescing
[

5

From the File menu, select New
then Project.

@ rowernaces2110 ([

File | Edit View Debug Tools DeltaTau EtherCAT  Window  Help
New * |3 Project... Ctrl+Shift=N
Open Y File. Ctrl+N Je
Close T
Position
Close Solution
. Position
Upload Project From PowerPMAC
W Save Selected ftems Ctrl+5
Save Output As...
WM Save Al Ctrl+Shift+S
Export 3
Import 3
[ Page Setup...
= Print... Ctrl+P
Recent Files 3
Recent Projects and Solutions 3
B Exit Alt+F4
6 Enter a project name and
location, and select OK. s
¥ Recert Sort by Defaul - P
e i Deut A B AL Type: Pnne'Fﬂ(
c - A b PormerPMAL propest
PewedMAL Solution I ProsacPMAL with TtharCAT [Accntic) PorwaDRAAL ‘
Pouserftick LY PoweRhAAC
ame: PowerFMACS
Location: et Smrtin_ipe_1\ Do PowerPhUAC I0E - [ e |
Sahation name BrweBhACS v Create directonfor solution
[ o || conen

12



6.2.2. Initial Settings of the Controller
Configure the initial settings for the Controller.

IE' Precautions for Correct Use

Configuring the initial settings clears all data in the Controller memory. Back up necessary

data in advance.

In the Terminal tab page, type the

$$$*** command to reset the
Controller to factory default.

@ PowerPMACS - PowerpMac DE 22119 (NN

File Edit View Project Build Debug Tools DeftaTau E
[8-a-28$ % [ - & - Debu
i @ StatPage ¥ Communication Setup | ] Terminal € Position

Watch Window B 1 x

Command/Query Response
Sys.ServoCount 2764277
Sys.ServoPeriod 1
ECAT[0].Enable 0
Motor[1].5ervoOut 0
Motor[1].Pos5f 1

Terminal

2

Select System — CPU — System

in the Solution Explorer.

Solution Explorer * 1 x
@ o-d|p-=
Search Solution Explorer (Ctrl+:) P~
1 PowerPMACS -
4 [ System
4 [Z CPU
3 Hardware
[ EtherCAT
3 Motors
1 Ceordinate Systems
b [ Encoder
b [3 C Language
b 3 Configuration
P [3d Documentation
b 3 Log -

Solution Explorer

3

Select Global Clock.

CPU Settings

Global Clock

Structure Elements

Advanced View ‘




Specify Servo Frequency.

Select the Servo Frequency Global Clock Setings

setting from 4 kHz, 2 kHz, or h ;
Phase Frequercy F e

1 kHZ Servo Frequency 1.000 - khz

Click the Accept button.

MNew clock  PowerPMAC
Items )

settings Value
Servo Period (msec) 1.000 1.000 -

EtherCAT option detected and no Master Gate -
detected, using internal clock by setting

. asys.CPUTimerlntr = 1. For EtherCAT the
ServoPeriod must be multiple of 62.5 usec. On
Accepting the clock issue save and type $355 in -

= Commeonly Used Structure Elements Accept

If you have changed the servo
frequency setting, type the SAVE
command in the Terminal tab
page of Power PMAC IDE.
When complete, the “Save
Complete” message appears in

Terminal

SAVITIY 1L T IS L DTSN PSS L 1dasT ]

Saving To Flash: Mounting the flash

Saving To Flash: Finished SAVING to flash

Save Completed

the Terminal tab page.

Click Delta Tau —
. PowerPMACS - PowerPMAC IDE 4.2.1.19 —

Communication Setup on the ) _ _ _

File Edit View Project Build Debug Tools DeltaTau EtherCAT
toolbar to display the Device fto-o | ERET |9 - @ -|[pebug - |am
PI’OpertIeS d|alog box i -] Terminal 4 Position [@] Watch

& Communication Setup

Watch Window

Command/Qui

Sys.ServoCount | Test ] l Apply ]
ECAT[0].Enable [
— . . _dlll 4 Device -
ECAT[0].Enabldil| 1P Address 192.168.0.200
.. N Fort 22 =
ECAT[0].Enabilg] Frotocal 55H B [

User root -

Sys.ServoPeriod 1P Addross |E
Set IP Add
Sys.ServoDeltaTl| ® ress

Sys.FltrservoTi

Svs‘MaXSeonﬁh—'-———M—
Sre MinSarunTima 1 ATINANNNANNANANNE ,7




In the Device Properties dialog

- 1
box, select No Device for IP | FErEmiEREiE —
Address, then click the Apply Test Apply I
button. e

4 Device -
This operation sets the Controller LPUerdrESS £
to the offline state. Fotocal 35H )

1P F_lddress. ““““

Set IP Address

Restart the Controller.

The servo frequency that has
been set is reflected.

Wait until the startup process of
the Controller is complete. Then
click Delta Tau — [ @ Device Properties Lﬂw
Communication Setup on the m Apply
toolbar to display the Device

Properties dialog box.

In the Device Properties dialog 1P Address [

Part
box, return the IP Address to the Protocol SSH
. . . Elser . Tu_t ------ 1
previous setting, then click the P Addrocs
Apply button. Set IP Address

|—||
This operation sets the Controller

to the online state.




| 6.3. Installation of ESI Files
Install the ESI file for the Slave into Power PMAC IDE.

M Precautions for Correct Use
Prepare the ESI file described in this section in advance. Contact your OMRON

representative for information on how to procure the ESI file.

EtherCAT | Window Help

1 From the EtherCAT menu of Power @ PowerBMACS - PowerPMAC IDE 4.2.1.19

File Edit View Project Build Debug Tools Ita Tau
PMAC IDE, Se|eCt ESI Manager ‘o - ‘ "B o-2 W | ¥ | ‘ Debug [ ESI Manager B Start -
o — fewgeiobon | 7] Tas

@ Start Page & Communication Setup ‘ E|Terminal =

Wakch Window
Command/Query Response
Sys.ServoCount 577552

ECAT[0].Enable=1 #2

2  Confirm that Omron E3NW-ECT.xml l" venager @Ml
ESI Files

IS reQIStered in the ESI flle IISt Of ESI Select an ESI file which should be deleted or exported or add new ESI files.

& Delta Tau Data Systemns, Inc. .

Manager.

I | Omron Corporation

Omron 3G3AX-MX2-ECT.xml|

Cumron RETAY B ECT vl
s

—
Number of ESI files: 41
Number of devices: 360

Add Folder Delete Export Close

If it is not yet registered, click Add File
and register Omron E3NW-ECT.xml.

= Add ESl File ==
@Qo\ <« Documents » SystemEsiFiles 2|
Organize =  New folder = - @
¢ Favorites - Documents library Arangeby: Folder =
B Deskeop SystemEsiFiles
4 Downloads e .
L Recent Places | [
U Iibroges =] Omron FH-nooexe 3
(2 Documents ] Omran FQ-Ms12x-ECT T
o Hidac 2] Omron FZMIL-XXX-ECT
i Pictiser: =] Omron GRT1-ECT_Ver2 0
B videos ] Ormron GX-Analog 10
N LT P — ’
File name: Omron E3NW-ECT v [EstFiles (raemi) -

3 Click Close to close the ESI Manager.

16



I 6.4. EtherCAT Communications Setup

Set up EtherCAT communications.

IE' Precautions for Correct Use

Before taking the following steps, make sure that the devices are connected via an Ethernet
cable. If they are not connected, turn OFF the power to the devices, and connect the Ethernet

cable.

6.4.1. Communications Setup for the EtherCAT Master

1 Connect the Controller with
slave devices using an Ethernet
cable.

* Refer to the manuals for slave
devices to configure them.

2 Select System — EtherCAT in
the Solution Explorer and
right-click on EtherCAT, then
select Add EtherCAT
Master(Acontis).

1 Mew Solution Explorer View

Properties

Scope to This

Add EtherCAT Master (Acontis)

0.00 rev

0.00 rev

0.00 rev

0.00 rev

Alt+Enter

Solution Explorer

W o -
Search Solution Explorer (Ctrl+:)
1 PowerPMACS

4 [ 7 System
P 3 CPU
[ Hardware

3 Motors
[ Coordinate Systems
[ Encoder

C Language
Cenfiguration

i Nnvenmantatinn

b

17



2 Master0 (Deactivated) is added | solution Explorer 1 x
to Solution Explorer. ARIRCI- BV R

Search Solution Explorer (Ctri+:) Ll

—1 PowerPMACS
4 [z System
P 3 CPU
3 Hardware
4 [ EtherCAT
| & Master0 (Deactivated) |
3 Motors
[d Coordinate Systems
b Cd Encoder
3 C Language
[ Cenfiguration
[ Documentation
[d Leg
3 PMAC Script Language

v v v v v

Solution Explorer

g3  Inthe Master tab page, specify a [taseo caca=:) - « GGG

Device Editor

communication period for Cycle :
Master |Topology View

Time [us].
General
Unit Name EtherCATSuite Master
* You must specify the | cvele Time [us] (1000 | .

Source MAC address
communication period in

Slaves connected to local system

accordance with the servo

Network Adapter O—7L TU748#E 5 ( Intel(R) 1210 Gigabit Networ]
frequency of the Controller.
1000 us iS Set in th'S dOCUment. Slaves connected to remote system
1P Address 192 168 ., 0 _200
Port 6000
Master-Instance 0
Networks: 1| Slaves: 0 | | state: | mode: conFiG

Correspondence between the servo frequencies of the
Controller and communication periods is as follows:

2 kHz : 500 us

1 kHz : 1000 us

18



Select System — EtherCAT in

the Solution Explorer and

Following Error

Solution Explorer
@ o3| F -

Search Solution Explorer (Ctrl+:)

right-click on Master0 0.00rev
. 1 PowerPMACS
(Deactivated), then select Scan e 4 [ System
0.00 rev b [3CPU
EtherCAT Network. £ Hardware

0.00rev ~

Configuration Mode

Diagnosis Mode

| Scan EtherCAT Network |

Append Slave
Paste Slave Ctrl+V
Import Slaves from ENI
Export ENI File
Load Mapping to PowerPMAC
Load Mapping to PowerPMAC From ENI
Activate EtherCAT
Edit Topology
EoE Endpoint Configuration
¢ Open
Scope to This
New Solution Explorer View

A Properties Alt+Enter

4 [ EtherCAT

ors

dinate Systems
ader

uage

ration

entation

script Language

2@l Class View

ctivated) File Proper

Motors =
Master(
Cr¥lser

Make sure that the slave is

Solution Explorer
@ o-&| f -

Search Solution Explorer (Ctrl+:)

displayed in the Solution
Explorer.

1 PowerPMACS
4 |7 System
P 3 CPU
[ Hardware
4 [ I EtherCAT
4 & MasterD (Deactivated)

illl Slave_1001 [E3NW-ECT] (1001)

3 Motors
[ Coordinate Systems
I [ Encoder
[ C Language
[ Configuration
3 Documentation
[ Log
[ PMAC Script Language

Solution Explorer EeEE=RUT=IT

19



6.4.2. Distributed Clock Setup

1

Setting Distributed Clocks (DC)
for Master

In the MasterQ (Deactivated) tab
page, select Distributed Clocks
tab.

Solution Explorer
@ o-F[p =

Search Solution Explorer (Ctrl+:)

1 PowerPMACS
4 | System
B3 CPU
3 Hardware
EtherCAT
4 B Master0 (Deactivated)
Tl Slave_1001 [E3NW-ECT] (1001)

4 Motors
[J Coordinate Systems
I 3 Encoder
[ C Language
1 Cenfiguration
1 Documentation
[ Log
[ PMAC Script Language

Solution Explorer BeEECRYUI

Master0 (Deactivated) + X

Device Editor

r——
‘ Master ‘l Topology View H Process Data Image ” Variables H Advanced Options ” Slave to S\avl‘ Distributed Clocks ‘IaSks + Sync Umts‘

Reference Clock

Name Slave_1001 [ZW-5000] (1001)

Clock Adjustment
@ Master shift (EtherCAT Master Time controlled by Reference Clock)
7 Bus shift (Reference Clock controlled by EtherCAT Master Time)

O External Mode (Reference Clock controlled by External Sync Device)

Options
[] Sync Window Monitoring

[] Show 64Bit System Time

Slaves with active DC

Slave_1001 [ZW-5000] (1001)

Networks: 1 | Slaves: 1 ‘

| state: @ @ | Mode: CONFIG

2

Select Master Shift (EtherCAT
Master Time controlled by
Reference Clock).

Master0 (Deactivated) + X
Device Editor

| Master | Topology view | Process Data image | variables | Advanced Options| Slave to S\ave‘ Distributed Clocks ‘T55k5 + Sync Units |
Reference Clock
Name Slave_1001 [ZW-5000] (1001)

@ Master Shift (EtherCAT Master Time controlled by Reference Clock)

_) Bus Shift (Reference Clock control y EtherCAT Master Time,

7) External Mede (Reference Clock controlled by External Sync Device)

Options
[C] Sync Window Monitoring

[T] Show 64Bit System Time

Slaves with active DC

Slave_1001 [ZW-5000] (1001)

Networks: 1 | Slaves: 1 State: @ & | Mode: CONFIG

20




B When using in DC mode

3

Setting Distributed Clock (DC) for
the Slave

In the Solution Explorer, select
the target slave and display the
Distributed Clock tab page.

Solution Explorer 1 x
@ o-ar -
Search Solution Explorer (Ctri+:) P

1 PowerPMACS
4 [ System

b [3 CPU

[ Hardware
4 [z EtherCAT

Ma ackiatod
[EM Slave_1001 [E3NW-ECT] (1001)

3 Coordinate Systems
b [ Encoder
b [d CLanguage
b 3 Configuration
b [ Documentation
b [J Log
b [ PMAC Script Language

Solution Explorer
Sve_to0: Ew-ecr1 Goon) < [

Device Editor
[ General [ PDO Mapping | Variables | Advanced options | Distributed Clock ffnit Commands | CoE Object-Dictionary | Sync Units |

-

Distributed Clock

Operation Mode Free Run -
Sync Unit Cyde (us) 1000
Overwrite Mode ]
Sync Units
Syne Unit 0
Cycle Time
Sync Unit Cycle 1 0us

User defined

shift Time (us)

Syne Unit 1
Cydle Time

Sync Unit Cycle 1 0us

Sync 0 Cycle X1 Ous

User defined

Shift Time (us) ~
Networks: 1| Slaves: 1 | | state: | Mode: conFiG
4  Select the Overwrite Mode Sive_io0n (v G0y [
Divicr: Editor

check box and specify Shift
Time.

| General FOO Mapging | Variabées Auuamdopt.ion!. Distributed Clock Init Commands | CoE Cbject-Dictionany | Sync Linits

Distributed Clock

9| Syne Units
¥ Sync Unit O

Cycle Time
& Syne Unit Cyele L  =|1000us

User defined
—
I Shift Tirme (1) 500 I

Sync Unit 1

Cyele Time

shift Time [us) B

Networks: 1| Slaves: 1 | State: @ & | Mode: CONFIG

Correspondence between the servo frequencies of
the Controller and Shift Time values is as follows:

2 kHz : 250 us
1 kHz : 500 us

21



B When using in Free-Run mode

3 Setting Distributed Clock (DC)
for the Slave

In the Solution Explorer, select
the target slave to display the
Distributed Clock tab page.

Solution Explorer > 1 x
G o-d[Fp =
Search Solution Explorer (Ctrl+:)
1 PowerPMACS
4 [ System
P [ CPU
[ Hardware
4 [z EtherCAT
P T

[iM Slave_1001 [E3NW-ECT] (1001)

[Cd Coordinate Systems
I [ Encoder

b [3 CLanguage

b 3 Configuration

b [ Documentation

P 3 Log

b 3 PMAC Script Language

Solution Explorer

Device Editor

Seve_i00: ovw-zcr) Coon < [

Distributed Clock
Operation Mode Free Run -

Syne Unit Cycle (us) 1000
Overwrite Mode ]

Sync Units
Sync Unit 0
Cycle Time
Sync Unit Cycle 1 0us
User defined
Shift Time (us)

Sync Unit 1
Cycle Time
Sync Unit Cycle 1 0us
Sync 0 Cycle X1 Ous
User defined

Shift Time (us)

Networks: 1| Slaves: 1 |

| General | Ppo Mapping | Variables | Advanced Optians ‘lD\strlbuted Clock ‘Imt Commands | CoE Object-Dictionary | Syne Units|

-

State: Mede: CONFIG

Select FreeRun from the drop
down list for Operation Mode.

Slave 1001 [E3NW-ECT] (1001)

Device Editor

‘ General H PDO Mapping || Variables || Advanced Options | Distributed Clock

Distributed Clock

Operation Mode

Sync Unit Cycle (us)

Owverwrite Mode

|Free Run -

Free Run

DC for synchronization

Sync Units

Sync Unit 0

Display the Advanced Options
tab page.

Clear the Potential Reference
Clock check box.

Device Editor

T —

Overwrite Watchdog

Set Multiplier (Reg.: 0x400):

Set PDI Watchdog (Reg.: 0x410):
Set SM Watchdog (Reg.: 0x420):

Distributed Clocks
[C] Potential Reference Clock

| General " PDO Mapping " Variablesl Advanced Options IDistrit

2498 =
1000 = (100.0
1000 =(100.C
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6.4.3. PDO Map Settings

1

In the Solution Explorer, select
the target slave and display
the PDO Mapping tab page.

Solution Explorer > 1 x
@o-a[F -
Search Solution Explorer (Ctri+:) P~

] PowerPMACS
4 [ System
b 3 CPU

3 Hardware

4 [ EtherCAT

[ Coordinate Systems
b 3 Encoder
3 C Language
1 Configuration
[ Documentation
[ Log
[ PMAC Script Language

v v v v v

1001 [EINW-ECT] (1001) = =

Inputs’

257N trangmit FOO Mapping [excluced by Gl Galdo

F5RIR trariemit BOO Mapping (excluded by Gal8 Ca1BG1

259 trarienit PDO Masping BalBa2
Fasd ingut 3rd wor | Ox6100:01 103

260t ransmit FOO Meoping owlED3
Baad input 41h wes | 0w6100,04 15

4| 261st tranemit FOO Mapping 1B | ¥

PX Advenced Options | Distributed Clock | Init Commands | CoE Object-Dictianary | Sync Uinits

Outputs

Netwerks: 1| Slaves: 1 |

State: @ @ | Mode: CONFIG
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2 Setting PDO mapping (Inputs) Inputs
Check the Inputs field to make 261st transmit PDO Mapping Ox1B04
sure that check boxes are as 262nd transmit PDO Mapping Ox1B0S
fO”OWS D 263rd transmit PO Mapping Ox1B0G
D 264th transmit FOO Mapping 0x1BO7
*|f you want to use other data, D 265th transmit FOO Mapping Ox1BO3
clear the currently displayed 266th transmit PDO Mapping 0x1B09
check boxes and select other 267th transmit PDO Mapping Ox1BOA
desired check boxes. 268th transmit PDO Mapping 0x1B0B
D 270th transmit FDO Mapping 0x1B0OD
273rd transmit PO Mapping Ox1B10
D 274th transmit PO Mapping Ox1B11
275th transmit PO Mapping Ox1B12
D 276th transmit FOO Mapping 0x1B13
277th transmit FOO Mapping Ox1B14
D 278th transmit FOO Mapping 0x1B15
2759th transmit FDO Mapping 0x1B16
D 280th transmit FDO Mapping 0x1B17
281st transmit PDO Mapping 0x1B18
D 282nd transmit PDO Mapping Ox1B1%S
283rd transmit PO Mapping Ox1B1A
D 284th transmit PO Mapping Ox1B1B
285th transmit FOO Mapping 0x1B1C
D 286th transmit FOO Mapping 0x1B1D
287th transmit FOO Mapping 0x1B1E
Setting PDO mapping Outputs

(Outputs)

Confirm that nothing is
displayed.
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6.4.4. Creation of an EtherCAT Network Information File

1 Select System — EtherCAT in

Solution Explorer * 1 x

. D o-ra|p =
the Solution Explorer and Search Scution Explorer (Cir+) o-
. . 1 PowerPMACS -
right-click on Master0 4 system
[ ev]

3 Hardware

4 [ EtherCAT
£ Master0 (Deactivated)

illl Slave_1001 [E3NW-ECT] (1001)

lotors.

(Deactivated), then select Load
Mapping to PowerPMAC.

Configuration Mode
Diagnosis Mode
Scan EtherCAT Network oordinate Systems
Append Slave

Paste Slave Ctri+v
Import Slaves from ENI

Export ENI File

Seri hd
Load Mapping to PowerPMA( lorer
| Load Mapping to PowerPMAC From ENI

Activate EtherCAT leactivated) File Properties

Edit Topology
EoE Endpoint Configuration
& open License Motors = 256
. Master0 (Deactivated)
Scope to This

Ci¥users¥pmaca¥Docume)
New Solution Explorer View

F  Properties Alt+Enter i o
2 An eni.xml file is added under Solution Explorer v B x
- - . . o - Gl ——
the Configuration directory in IR
Search Selution Explorer (Ctrl+:) -
the Solution Explorer. ] PowerPMACS
b 3 System

b [ CLanguage
4 [z Configuration

B enixml

[1 pp_custom_save.cfg
[ pp_custom_save.tpl
=) pp_disable.txt
=) pp_inc_disable.txt
=) pp_inc_startup.bxt
[ pp_save.cfg
=) pp_startup.txt
[ systemsetup.cfg

b [J Decumentation

b [J Log

b [J PMAC Script Language

Solution Explorer

An ECATMappmh f||e IS added Solution Explorer - B x
under the PMAC Script - gli::: EF‘VCT =
Language/Global Includes 1 PowerPMACS

directory in the Solution b System

[d C Language
EXplOI’er [ Configuration

4 Documentation

[ Log

[ PMAC Script Language

4 [ Global Includes

global definitions.pmh
(M) ECATMap.pmh

1 Kinematic Routines

b [ Libraries

b [ Motion Programs

b [3 PLC Programs

[

Solution Explorer




I 6.5. Controller Settings

6.5.1. EtherCAT Communications Check

Take the following steps to ensure that EtherCAT communications are available.
1 From the Terminal tab page, run

the ECAT[0].Enable=1 command

to start EtherCAT communications.

Terminal

ECAT[OL.Enable=1|

2 In the Terminal tab page or Watch
Window, make sure that the
ECAT[0].Enable value turns to 1.

Watch Window

Command/Query Response
Sys.ServoCount 12960793

* The OP mode is entered and ECAT[0].Enable |

EtherCAT communications are
established.

3 After making sure that correct
communications are available, run AC terminal
the ECAT[0].Enable=0 command = mmunication

o PowerPMAC at 192.168.0.200 successful

Terminal - I x

from the Terminal tab page to stop
EtherCAT communications.

4 In the Terminal tab page or Watch
Window, make sure that the
ECAT[0].Enable value turns to 0.

Watch Window
Command/Query Response
Sys.ServoCount 13312872
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6.5.2. Writing the User Program

Create programs to be used to check operations.
A specific language is used for the operation check programs. Refer to Power PMAC User’s
Manual and Power PMAC Software Reference Manual for details.

In the Solution Explorer pane,
open Project name — PMAC
Script Language — PLC
Programs — plc1.plc.

plcl.plc ® X

/{ Power PMAC Script PLC Program Template. |
/f The following Sample PLC PROGRAM is the st a
/{ Sample PLC PROGRAM

J
// open plc 1

Ho—mmmmmm User Code Goes Here---
close
/

100% ~ 4 4

Solution Explorer
W o-ap -

Search Solution Explorer (Ctr 0 ~

1 PowerPMACS
P 3 System
[3 C Language
[ Cenfiguration
3 Documentation
3 Log
% PMAC Script Language
b [ Glebal Includes
1 Kinematic Routines
I [ Libraries
P [ Motion Programs

4 | PLC Programs
[ plel.ple
Selution Explorer

[

In the programming area of the
plc1.plc tab page, write a
program as shown on the right.

This sample program
substitutes slave data
Slave_0_4001_1_No_01Detecti
onLev for variable P1001.

* In this example, PDO mapping
is assumed to be the default
setting. If you want to change
PDO mapping, rewrite the
“Slave_0....” description.

open plc 1
while(sys.ecatMasterReady==0)};

ECAT[0].Enable=1;

close

P1001 = Slave_0_4001_1_No_01DetectionLev;
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Setting the start of the user
program

In the Solution Explorer pane,
open Project name —
Configuration —
pp_disable.txt.

pp_disable.txt &

fI# K
&*A

disable plc @..31

//Kill all the moters (This g
//Abort AlL Programs -
//Disable all Script PLCs

clear all buffers

100% ~ 4

Solution Explorer
@& o-a p -
Search Selution Explorer (Ctrl+ 0 ~

1 PowerPMACS

b [3 System

b [3 CLlanguage

4 [ Configuration
[} ECATCenfig.cfg
] eni.xml

[} pp_custom_save.cfg

[1 pp_custom_save.tpl

=] pp_disable.txt

=] pp_inc_startup.bxt
[} pp_save.cfg
=] pp_startup.txt
[} systemsetup.cfg
b [J Documentation
b [3 Log
b [ PMAC Script Language

In the programming area of the
pp_disable.txt tab page, add
the program shown on the right
to the last line.

The pp_disable.txt program is
automatically executed when
the Controller starts.

This example program runs the
PLC1 script.

enable plc 1;
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6.5.3. Project Data Transfer
Transfer the created project data to the Controller.

/A WARNING

When the user program and “configuration and setting” data are transferred from
Power PMAC IDE, devices or the machine may perform unexpected operations.
Therefore, before you transfer project data, ensure the destination slave is

operating safely.

Transferring project data restarts the Controller and interrupts communications

with slaves. The time that communications are interrupted depends on the
EtherCAT network configuration.

Before you transfer project data, make sure that the slave settings will not
adversely affect the devices.

1 In the Terminal tab page or
Watch Window, make sure
that the ECAT[0].Enable value
is 0.

Watch Window
Command/Query Response

Sys.ServoCount 13312872

ECAT[0].Enable

If the value is 1, run the
ECATI[0].Enable=0 command
from the Terminal tab page to
stop EtherCAT
communications.

Solution Explorer * 0 x
W o-a|p =

Search Solution Explorer (( Q@ ~

2 Downloading a project

Right-click the project name in

. PowerPMACS |
the Solution Explorer pane on [y " M System

the upper right of the IDE Rebuild 73 C Language
. Clean 1 Configuration
screen, and select Build and “ Documentation
D I All P New Solution Explorer View "3 Log
ownload rograms to Build and Download All Programs 1 PMAC Script Language
run the build and download. l—mp CHEE

Add Macro Project
Export Project with IP Protection...

* The transferred project is not Export Project Template...

yet saved to the Controller at ¥ cut Ctrl+x

this stage. Unload Project
¢ Open Folder in File Explorer

If you turn OFF the power to

A Properties Alt+Enter
the Controller, the transferred e i . D—

project will be discarded.
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Make sure that there are no
errors in the Output Window.

* If the transfer fails, check
details of the error in the
Output Window.

If the error is a program error,
you must review the program.
If the error is related to
EtherCAT settings, return to
6.4 EtherCAT
Communications Setup and
check whether there are any
incorrect settings.

The program starts running
when it has been downloaded
successfully.

EtherCAT communications
are in the OP state. In the
Terminal pane, confirm that
the variable (P1007) changes
to No.1 Sensor Detection
Level.

* If the variable does not
change, check that the
ECAT[0].Enable value is 1 in
the Terminal tab page or
Watch Window.

If the value is 0, run the
following command from the
Terminal tab page.

enable plc 1

Terminal

uccessful

enable plc 'I|




After you have confirmed an
appropriate operation, save
the project to the Controller.

Run the save command from
the Terminal tab page.

* The save command stores
the downloaded project in the
Controller. This operation
saves the settings to be
executed automatically when
the power to the Controller is
turned on.

Terminal

Required disk =
Saving To Flash

Saving To Flash: Mounting the flash
Saving To Flash: Finished SAVING to flash

Save Completed

ave|
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7. Appendix Saving and Loading a Project

The following describes the procedures to save a Power PMAC IDE project on the computer, and to
reuse it.

I 7.1. Saving a Project

1 Creating a Configuration File s isoriecyoooy) - [RE— STE
= @ o-a p-
—3 Search Solution Explorer (Ctrl+) J-3
. . . ] R88D-1SN
Create a Configuration File to g
(4 Clanguage
B oo
save parameters you have D ecATConfigets
=] enixml Scope to This
[ pp_custom_savecfg | ER  New Solution Explorer View
changed. gzz-zf;t;:jmp‘ £ Properies Al Enter
2 ppinc_disablect Upload Config Files
2] pp_inc_startup.bet
. . - . . O pp savecig I Generate Config File I
Right-click Configuration in the 2 pserps
systemsetup.cfg
. b 4 Documentation
Solution Explorer pane, and =T
b [ PMAC Script Language
select Generate Config File.
A Configuration File is added to
Configuration.
Enter a file name in the textbox, ? B
2 @ pe_dificfy [

then click the OK button.

Fleaze tvpe a name for the Config File.

| e — =
3 Right-click on the Configuration D) pp_save.cfg
. = tartup.td
File, and from the menu, select - e
Check To Download Config File O & Open
. o b 3 Dy Open With...
to include it in files to be b 3 Lo :
. <>  View Code
4 [ = PH
downloaded. 4 5 Scope to This

Mew Solution Explorer View

Exclude From Project

Solution Ex
M Copy Ctrl+C

| X Delete Del

R88D-1SN Rename Y

s O | I Check To Download Config File

B FileEncl & properties Alt+Enter
Enable Erluypr.run Mo

B Misc
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4

Saving a Project

In the File menu, run Save All to
save the project on the computer.

@ rea0-1sn-poverrmacoea 2110 (N

|Fi4= Edit View Project Build Debug Tools

W

Open

Cloze
E3  Close Project

Upload Project From PowerPMAC
B SaveRBED-15M.cfg

i - [] Az,
Save All

Export

Import

Page Setup..

Print

Recent Projects and Solutians
B Exit

Ctrd+5

Ctrls Shifts S

AlesFd

3

|-

Delta Tau  EM
5 .| Debug

e Position E

Motor[1].Idata[11]=1176256512
Motor[1].Idata[12]=118874112@
Moter[1].Idata[l3]=@
Motor[1].Idata]14]=8
Motor[1].Idatal151=8
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I 7.2. Loading and Downloading a Project

1 Start Power PMAC IDE, and
connect to the Controller.

2 In the Terminal tab page, type the
$$$*** command to reset the
Controller settings to factory
default.

Terminal

ymmunication to

|$$$ﬂ*|
PowerPMAC Messages MIEIUILEIN Terminal Output

3 In the File menu, click Open —
Project/Solution to load the
project that you saved.

@ PovePMACIDE42119 & 1P: 192.168.0.200  Type: MOTION COf

File | Edit View Debug Tools DeltaTau EtherCAT  Window  Help
—
Open ¥ | §3  Project/Solution... Ctrl+Shift+0
Close 2 File.. Ctrl+0
Close Project
Upload Project From PowerPMAC
Save Selected tems Ctrl+S
Save Selected ltems As...
¥ Save Al Ctrl+Shift+S
Export 3
Import 3
Page Setup...
Print... Ctrl+P
Recent Projects and Solutions 3

Exit

Alt+Fd

4 Right-click Configuration in the
Solution Explorer pane, and select
Download Config Files to
download the file to the Controller.

_____ - e

v 1 X
ES T,
= @ o-a| L=
—{f Search Solution Explorer (Ctrl+;) P~
1 R88D-1SN
P [ System

P [ Clanguage
| 4 B Codfiguetion |
O Add C
Scope to This

MNew Solution Explorer View

ST s N e W 1173
e @

Properties Alt+Enter

E Download Cenfig Files

+ [ R88D-15N.cfg
[ systemsetup.cfg
I+ [ Documentation
P [d Leg
P 3 PMAC Script Language

Solution Explorer
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Right-click the project name in the
Solution Explorer pane, and select
Build and Download All
Programs to run the build and
download.

When the download process is
complete, make sure that there are
no errors in the Output Window.

___- PrEr= T X

+ R

= @& o-aF =

-

—A8 Search Solution Explorer (Ctrl+;) P -
BRD-i

| RSD- G
b [CF Sys ki Build
p C@cCy Rebuild

4 [Z Col Clean

Mew Solution F_xg\orer\fiew
Build and Download All Programs
ST

)
2l

m

e Add Macro Project

=

f Export Project with IP Protection...

2 P d]

0 Export Project Template...

S T Ctrl+X

‘o Unload Proj
nload Project

o ]
b [d Do (<4 Open Folder in File Explorer
b O3 Lo f Properties Alt+Enter
b g PM ey

Selution Explorer

Stopping a program

If a program is running, execute
the following command from the
Terminal tab page to stop the
program.

disable plc 1

ECAT[0].Enable=0

R

|disable ple 1

PowerPMAC Messages JIEUUIGEIN Terminal Output

Terminal

P

|ECAT[D].EnabIe= 0

PowerPMAC Messages IIEGUIGEN Terminal Output
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Saving the downloaded settings
and programs

After the download process is
complete and you make sure that
there are no errors in the Output
Window, run the save command
from the Terminal tab page.

* The save command stores the
downloaded project in the
Controller. This operation saves
the settings to be executed
automatically when the power to
the Controller is turned on.

Terminal

|save4

PowerPMAC Messages MIEIUILEIN Terminal Output

Restarting after download

Run the following command from
the Terminal tab page to restart the
Controller with the downloaded
project.

$$$

Terminal

Saving To Flash: Mounting the flash

Saving To Flash: Finizhed SAVING to flash

Save Completed

|sssl

PowerPMAC Messages MEINIGEN Terminal Output
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8. Appendix Troubleshooting

I 8.1. Factors Causing EtherCAT Communications To Be Unavailable, and

Corrective Actions

Description

Factor

Corrective Action

The link is not established.

The Ethernet cable is broken or
the specified cable is not being
used.

If the Ethernet cable is broken
or if the specified cable was not
used, replace the cable.

A connector on the Ethernet
cable used for EtherCAT
communications is
disconnected, the contact is
faulty, or parts are faulty.

Reconnect the connector and
make sure it is mated correctly.

A slave within the EtherCAT
network configuration failed.

Replace the slave.

EtherCAT communications do
not start.

ECAT[0].Enable is set to 0.

From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

The EtherCAT network
configuration in the Controller
does not agree with the
physical network configuration.

Review the settings according
to the procedures provided in
6.4 EtherCAT Communications
Setup.

The Ethernet cable is broken at
a slave in the network, or a
connector is disconnected.

Connect the Ethernet cable
correctly.

Some errors have occurred,
and the ECATI[O].error is setto a
value other than 0.

Check the ECATIO0].error value.

A synchronization error occurs
at a slave.

The distribution clock is not set
correctly.

A slave in Free-Run Mode is set
to the reference clock.

Review the settings according
to the procedures provided in
6.4.2 Distributed Clock Setup.

The servo task processing time
exceeds the set period.

Review the program or servo
frequency to adjust it, so that
the servo task processing time
does not exceed the period.
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I 8.2. How to Check for Errors

8.2.1. Checking the EtherCAT Status
You can check the EtherCAT status from Diagnosis Mode of Power PMAC IDE.

Right-click on Master0 (Deactivated) under EtherCAT in the Solution Explorer, then select
Diagnosis Mode to open the Diagnosis Mode page

Solution Explorer 1 x
G| o-a|p--
Search Solution Explorer (Ctrl+:) L~
4 [ System -
b 3 CPU

1 Hardware
4 [ EtherCAT

—_— il Slave_1001 [E3NW-ECT] (1001)
Diagnosis Mode I otors
Scan EtherCAT Network oordinate Systems
ncoder
Append Slave nquage
Paste Slave Chrl+V figuration
umentation

Import Slaves from ENI

Export ENI File C Script Language

Load Mapping to PowerPMAC

e Class View
Load Mapping to PowerPMAC From ENI

Activate EtherCAT 7 E
ctivated) File P i -

Edit Topology L)) (AR

EoE Endpoint Configuration
(& @z License Motors = 256

Scope to This 3 Master0 (Activated)
New Solution Explorer View creusers¥pmacd¥Docume
JF  Properties Alt+Enter [ Acontis

You can check the status of the slaves in the Diagnosis Mode page.

Masterl (Diagnosis) & X
Device Editor
| General |Proce55 Data Image | Watch list | Performance | Variables | CoE Object-Dictionary | History |

State Machine

Current State Op
Requested State Op
Init Bootstrap
Change State Pre-Op Safe-Op
Information Frame Counter
MNumber of found slaves 1 Sent frames 1091052
Mumber of slaves in configuration 1 Lost frames 0
Mumber of DC slaves 1 Cyclic frames 1080854
DC in-sync Yes Acyclic frames 10198
Topology Ok Yes Clear counters
Link Cennected Yes
Slaves in Master State Yes
Networks: 1 | Slaves: 1 State: @ @ | Mode: DIAGNOSIS
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8.2.2. Checking the Controller Status

In the Status page of Power PMAC IDE, you can check the status of the motor, coordinate system,
and system.

To display the Status page, click Status on the toolbar.

M Global Status
You can check system errors such as the WDT error.

Status

Motor Status] Coordinate Status ~ Global Status 1 MACRO Status 1

Global Status

Description Status Description Status
False HWChangeErr False
BufSizeErr False NoClocks False
CenfigloadErr False ProjectLoadErr False
Default True PwrOnFault False
FileConfigErr False WOTFault MaFault
Flash5izeErr False

39



B Motor Status
You can check deviation errors, limit errors, and other states of the motor.

Status

Motor 1 =

Description

AmpFault
AmpWarn
AuxFault

EBIDir
BlockRequest
Closedloop
Csolve
DacLimit
DesVelZero
Encloss

FeFatal

FeWarn
GantryHomed
HomeComplete
HomelnProgress

® Motor activated

Motor Status 1 Ceordinate Status] Global Status] MACRO Status 1

Status Description
LtFault

False InPos

False InterlockStop
False LimitStop

Plus MinusLimit
False PhaseFound
False PlusLimit

False SoftLimit

False SoftLimitDir
[Tide ] seftMinusimit
False SoftPlusLimit
False SpindleMotor
False TraceCount
False TriggerhMove
False TriggerNotFound
False TriggerSpeedSel

Status
False
False
False
False
False
False
False
False
Plus
False
False
False
0
False
False
MaxSpeed

B X

B Coordinate Status
You can check deviation errors, limit errors and other states of the coordinate system.

Status * 0O X

Motor Status  Cocrdinate Status l Global Status] MACRO Status ]
Coordinate System ] =
Description Status Description Status -

AmpEna False LookAheadActive False
AmpFault False LookAheadChange False
AmpWarn False LookAheadDir Forward
AuxFault False LookAheadFlush False
BlockActive False LookAheadlookBack False
BlockRequest False LookAheadReCalc False
BufferWarn 0 LookAheadStop False
CC3Active False LookAheadWrap False
CCAddedArc False MinusLimit False
CCMode Off MoveMode LineCircle
CCMoveType Dwell PlusLimit False
CCOffReq False ProgActive False
ClosedLoop False ProgProceeding False
ContMotion False ProgRunning False
Csolve False SegEnabled False
DesVelZero False SegHaltReq False
Encloss False SegMove Off
EndDelayActive False SeghMovelccel False
ErrorStatus MoError SegMoveDecel False
FeedHold Off SegStopReq False
FeFatal False SharpCornerStop False
FeWarn False SoftMinusLimit False
HomeComplete False SoftPlusLimit False
HomelnProgress False TimerEnabled False
LtFault False TimersEnabled False
InPos False TriggerMove False
InterlockStop False TriggerMotFound False -
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9. Appendix ECAT][i] Structure Elements

The Controller uses motion controller technology developed by Delta Tau Data Systems, Inc.,
(hereafter referred to as DT) in the U.S., however, the ECATIi] structure elements differ from those of
DT controllers. The following table shows the major changes that have been made from DT

controllers.

Element name

Description

Change

ECATI[i].Enable

ECATI[i].LPIO[K]

ECATIi].Slave[j]
ECATi].Error

ECATIi].LinkUp
ECATI[i].LPDomainOutputState
ECATI[i].LPDomainState
ECATI[i].LPRxTime
ECATI[i].LPTxTime
ECATIi].MasterStat
ECATIi].RTDomainOutputState
ECAT[i].RTDomainState

Enabling the EtherCAT
network

Elements of low priority
I/O module

Slave elements

Error code of enabling
EtherCAT network

Status data structure
elements

0: Disable, 1: Enable
(2 and 3 are not supported.)
Not supported

Not supported

$ 9811000C: Invalid network
configuration

$ 9811002E: Disconnected network
connection

Not supported
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10. Revision History

Revision Revised date Revised content

code

01 Apr, 2019 First edition

02 Jan, 2023 - Made changes accompanying the addition of CK5M-CPU1

01 Unit.
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